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Preface

This manual provides detailed information on the operation of PLC software KV STUDIO when E1
MECHATROLINK-III drive is used with KEYENCE KV-7000 series PLC.



Specifications of Software/Hardware

Name Version of Software/Firmware

Software (Thunder): 1.9.16.0 or above

Firmware: 2.8.16

E1 MECHATROLINK-III Drive

Software (KV STUDIO): 11.61 or above

Firmware: 2.400 or above

KEYENCE KV-7500

KEYENCE KV-XH04ML Firmware: 1.106 or above
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1.1 Introduction of hardware device

Positioning
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Figure 1.1.1

KEYENCE KV-7500 is a controller composed of a CPU unit and one or more positioning motion units.
For the first use, users need to combine CPU unit and positioning motion unit and prepare a 24 VDC 1.8

A power supply for CPU unit. CPU unit is mainly used to connect with the computer, and positioning
motion unit is mainly used to connect with the drive.
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Figure 1.1.2
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B Field A
Model of CPU unit.

m FieldB
LCD screen display.

B FieldC
Computer USB port.

®m  FieldD
CPU unit network port.

® FieldE
LED display lights.
Red light: Unit connection failure.
Green light: Successful unit connection.

B FieldF
Model of positioning motion unit.

B Field G
Motion unit network port.
Users need to adopt Keyence's special network cable for motion unit and drive; ordinary network
cables may not be able to communicate successfully.

HIWIN MIKROSYSTEM CORP. 1-3
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1.2 IP setting and connection

1. For first-time setup, connect USB cable and network cable to CPU unit and the computer, and open
KV STUDIO software interface.

Bl kv sTUDIO - a =
File(F) View(V) Monitor/Simulator(N) Operation recorder/Replay(R) Tool(T) Window(W) HelpiH)

DM ERRRE SRR us EPPAR M GESEE RSB TR

A EEEERIBBA®©® > NI AN Y > OUBOMI[ Jicomes|

Ready 2 USE .

Figure 1.2.1

2. Create a new project.

(In this step, press NO in "Confirm unit setting information" to prevent automatic generation of unit
configuration, which will be set in step 6.)

Bl kv sTuDio

- O X

File(F) I View(V) Monitor/Simulator(N)  Operation recorder/Replay(R) Tool(T) Window(W) Help(H)
3 Newprojecity.. GrisN (PRARPAMEKESEE L RELBL DT T
= Oenprome0) 120 N A K1 Y D> O US OB ] comem[ ]

Register sensor settings file(E)... ect x

Memory card(M) > Project nama(N) PLC model(K)

Printer setup(W)... [i N\ | [kw-7500 >

Recent projects(D) »  Position(P)

Exit00 [cw F 1S KEYENCEWVS11GKVS)| | Refer(s)...|

Comment(C) \

Figure 1.2.2

1-4 HIWIN MIKROSYSTEM CORP.



HIWIN. MIKROSYSTEM
MD37UE01-2310
Communication and module setup

3. Set IP address to 192.168.0.100, which is in the same network domain as the controller.

E1 MECHATROLINK-III Drive Complete Setup with KEYENCE KV STUDIO

Q Network Connections

+ @ > Control Panel » Network and Internet > Network Connections v D
Organize ~ Disable this network device Diagnose this connection Rename this connection
.

View status of this connection

| Ethernet - Ethernet 4(test) SRR AR BARIRESE 4 K (TCP/IPv4) Properties X
hiwinmikro.com.tw F HEHEEE
@ |ntel(R) Ethernet Connection (14) ... @27 |ntel(R) Gigabit CT Desktop Adapter | General
You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.
() Obtain an IP address automatically
(@) Use the following IP address:
1P address: 192 .168 . 0 . 100
Subnet mask: 255 .255 .255 . 0
Default gateway: . .
Obtain DNS server address automatically
(®) Use the following DNS server addresses:
Preferred DNS server: . .
Alternate DNS server: . .
[validate settings upon exit
[Tox ]| canel |
Figure 1.2.3
4. Switch KV STUDIO mode to Editor, so that the subsequent operations could be carried out.
Bl Kv STUDIO -[Monitor: KV-7500] - [0615 #] - [m] X
File(F) Edit(E) View(V) Program(M) ST/Script(S) Convert(A) Monitor/Simulator(N) Debug(D) Tool(T) Window(W) Help(H)
D"‘E b P 'E&EI q@,ii:":’i “ﬂz')ﬁﬁ%@ DOFS S5 i SFA FT ST ;‘a sgsﬂ 5

HE T R S

EEREERIDHRO@Or[MIIKA K YH>O

% O | : m : Comments Comment 1

Figure 1.2.4
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5. Select USB as communication path.

Bl kv STUDIO -[Editor; KV-7500] - [0615 #]
File(F) Edit(E) View(V) Program(M) ST/Script(S) Convert(A) Monfior]Simulatar(N} Debug(D) Tool(M Window(\W) He.-ip(H)

DvEERBE®0&LO | Rjus oAb QR SBEEBE ¥ & & 33
igisE _IEEH £ ip b kEEk 4 M ¥ > @ U M [editor -l

lect communication path

Figure 1.2.5

6. Click Unit configuration on the upper left side, and then right-click to select Unit Editor.

Bl Kv STUDIO -[Editor: KV-7500] - [0615 *]

File(F) Edit(E) View(V) Program(M) ST/Script(S) Convert(d) Mol
DM EBEPREm@ B us il
- R EER IR @@ > H I A
Project

Setup mail(T)...

Mail Command Maker(R)...
Simple PLC link setting(G)...
FTP client setting(J)...

Setup logging/trace(L)...

Error monitor(W)
Scan time monitor(S)

Performance monitor(A)

Change model(P)

Figure 1.2.6
1-6 HIWIN MIKROSYSTEM CORP.
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7. Click "Acquire the configuration information of the unit connected to the PLC" and press Yes to read

the existing positioning motion unit model of the user.

G Unit Editor - Edit mode - O X
File(F) Edit(E) Convert(P) View(V) Option(O) Window(W) Help(H)
o i Rk 4 = AR @
Acquire the configuration information of the unit connected to the PLC.
Select unit(1) Setup unit(2) |
iE 3T (i B8 [0] KV-750
E Function l
Socket function Not used(*) hd
[ Base
Leading DM No. DM10000
Number of DMs... 230
Unit Editor ket function

n socket function is used, the
lowing functions, settings may be

Unit settings are read in the initialization status. = n.m " ow :
At the same time, the content currently being edited will be : l,SOCkem Sockecsiosco S
discarded. Sl
£ OK?
Me:
’_ Yes No 1sage
Figure 1.2.7

8. When the models of CPU unit and positioning motion unit appear, click OK on the lower right side.

= Unit Editor - Edit mode = O
File(F) Edit(E) Convert(P) WView(V) Option(O) Window(W) Help(H)

o @ AGTEEEY AW 0

) A | Unit
R—7E00 rv-xEoanT | Selectunit(l) Setup unit(2)
|
Cur; e
Weight:4€0g
No set project.

Ho set project.

< >

Message

| Process Row No. [ Code essage

4 4 » M Y Message I
[editor  [[Line:2, Col:t || OK Cancel Apply

Figure 1.2.8
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9. Check if the model under Unit configuration is consistent with the model of actual controller.

. KV STUDIO -[Editor: KV-7500] - [0615 #]
File() Edit(F) View(V) Program(M) ST/ScriptS) Convert(d) Mo
DMBEREPBEma@ ) us z
—E2Z2E R TRiBY L

ax

Figure 1.2.9

10. Check if the communication path is USB, and press PLC Transfer > Execute. At this time, the display
light on the upper right side of the positioning motion unit will turn from red to green (refer to Field E in
Figure 1.1.2), representing successful setup of CPU unit and positioning motion unit.

Bl KV STUDIO -[Editor: KV-7500] - [0615 #]
File(F) Edit(E) View(V) Program(M) ST/Script(S) Convert(A) Monitor/Simulator(N) Debug(D) Tool(T)
e EH R (o @ B use BPOHGESE
' EEPEENT DB S | . O | |

Transfer items(l)

..
Unit setting info
Global device cgmments
Global label
CPU system setting
Program
Device default |nfo

Logginghrace zetting info
Ethemnet/serial function setting info
File Register setting Unit sefting info
User document
Positioning uhit parameter

EEEEEEEEEEE

Selectall(S) | Cancel all(D)
[ clear program in PLC(Q)

Transfer in PRQGRAM mode(P)
Transfer in RUN mode(R)

Cancel(C)

Figure 1.2.10
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11. After completing unit editor settings, select Serial as communication path and click Comm settings >
Ethernet > Search destination.

Bl Kv STUDIO -[Editor: KV-7500] - [0615 #]

File(F) Edit(E) View(V) Program(M) ST/Script(S) Convert(A) Monitor/Simulator(N) Debug(D) Tool(T) Window(W) Help(H)
O E2ERs =@ |BE PR EGES ™RSS
A EREERTITRDRAOO > HIUNIKKA KN Y W> O USOHE| edior

Comm settings
PC comm port

QO usB)

Ethernet settings

Pnddrusmlo.l].ﬂ.

Port No.(P) | 8500

[J Routing setting(R)
PC comm port - USB
wvia VT/DT : No
wvia network : No
Connected model :

Figure 1.2.11

12. Click the network card that is connected to CPU unit and then click on Execute.

Search destination X

Select network card

Network card (N) |intel(R) Ethernet Connection (14) 219-V ]

Intel(R) Ethernet Connection (14) 218-V/
IP address Intel(R) Gigabit CT Desktop Adapter

Subnet mask I 255.255.254.0 / |

Potho) [ 8so0 | |eecues | | St

Find Ethernet unit where broadcast packets reach. (KV only)
*Network load may increase according to the number of connected units.

Result

MAC address Connected Unit type IP address Project name

Figure 1.2.12
HIWIN MIKROSYSTEM CORP. 1-9
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13. After pressing Execute for a few seconds, the results will be displayed below. Select the connected
unit type and click Select.

Search destination X

Select network card

Network card (N) | Intel(R) Gigabit CT Desktop Adapter Mot

P address | 192.168.0.100 ‘

Subnet mask | 255.285.255.0 ‘

Port No.(P) 8500 Execute(S) Stop(B)

Find Ethernet unit where broadcast packets reach. (KV only)

*Network load may increase according to the number of connected units.

Result

MAC address Connected Unit type IP address. Project name
00-01-FC-34-TE-21 KV-7500 192.168.0.10

=

Figure 1.2.13

14. Click OK to complete the connection.

PC comm port

(O usB(U) O serial(s)

(®) Ethernet(E) (O Bluetooth(H) (O Modem(M)
Ethernet settings

IP address(l) \ 192 . 168 . 0 . 10 ‘ ISgarchdegt_(F)_,,I

Port No.(P) [ssuo | Conn. test(T)...

[[] Routing setting(R)
PC comm port : USB
via VT/DT : No
via network : No
Connected model :

Detail(A)...

Destinations(L) Cancel

Figure 1.2.14
1-10 HIWIN MIKROSYSTEM CORP.
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15. Switch KV STUDIO mode to Monitor, and check if the motion unit models are turned to green lights,
indicating the connection between PC and CPU unit is established.

Bl v STUDIO -[Monitor: KV-7500] - [0615 *]
File(F) Edit(E) View(V) Program(M) ST/Script(S) Convert(A) Monitor/Simulator(N) Debug(D) Tool(T) Window(W) Help(H)

iDmEBE2PREmR@OR [Etbernet _ T PRAP O SKEES LTI A
AEERRERITRBE @@ > (W KA K MY M> 2o

Figure 1.2.15

16. Check if the communication type of the drive is MECHATROLINK-III and is set to “Drive ready” state
(For detailed setting operation, please refer to "E Series Servo Drive Thunder Software Operation
Manual"). Set Access to Controller so that the positioning motion unit of Keyence controller can be
connected to the drive.

Thunder (1.9.10.0), Hub 1, Port 5
File Tools Settings | Access Help

N

------- Ver. 2.8.10

| Typ. MECHATROLINK-II |
------- Pwr. 110V / 220V, 1kW/
=--Mod.

MN/A
MN/A
Act. Position mode

....... Typ. Serial
. --Res. 23 bits, 8,388,608 .,
£ : ’
No Error
No Warning
M Senvo ready

¥ Main power is normal
[ Mo alarm oceurs
|7 Motor parameters are set

[F FSTP signal is off

Figure 1.2.16
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1.3 Axis configuration

1. Switch KV STUDIO mode to Editor. Click the positioning motion unit which will be connected to the
drive and open Axis configuration setting.
B Kv STUDIO -[Editor: KV-7500] - [0615 #]

File(F) Edit(E) View(V) Program(M) ST/Script(S) Convert(d) Monitor/Simulator(N)

O EEPEE =@ B Ethenet - BDRFEABRQ

R34000 DM10300

setting

Figure 1.3.1

2. Atthis time, the following screen will appear. Double-clicking Servo on the right, and the icon of a
servo motor will appear on the left. Please enter the relevant information of the drive on the lower

right side.
x
MECHATROLINK-IIl slave list
KV-XHO4ML
Setup max. number of axes 4 axes sv2
MECHATROLINK-IIl communication period(L) [500us =
(Control peried) ~——— = Servol
Help i
| Stepper
[e—T L
_| ‘ | tnverter
Swu ﬂ' LY
Axis1 i
f100) E Virtual axis
Senvo
Axis No.(N) 1 =
Axis comments(A)
Station address(D) GH=
Extended address(E) ‘D H
[ Automatic Parameter Reading(P)
Setup(S)
oK Cancel

Figure 1.3.2
1-12 HIWIN MIKROSYSTEM CORP.
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3.  Open the cover of drive panel and observe SW1 and SW2. The arrow direction of knob indicates
the station address of the drive, SW1 refers to tens digit, and SW2 refers to units digit. However,
some station addresses are not supported by the drive, as shown in the table in Figure 1.3.4. If
SW1=0, the value of SW2 cannot be a number from 0 to 2; if SW1=F, the value of SW2 cannot be a
number from 0 to F. If the station address of the drive is the above number, please turn the knobs of
SW1 and SW2 to avoid the above range and restart the power. Finally, enter the station address of
the drive to Station address shown in Figure 1.3.4.

Figure 1.3.3
Sevo
Axis No.(N) =
Axis comments(A) I:’
IStatlun address(D) 8 i |
Extended address(E) 0 5
SW1 SW2 Station ACICIFGSS Automatic Parameter Reading(P)
0 Oto 2 Reserved
0 3 03h
E F EFh
OK C. |
F OtoF Reserved anes
Figure 1.3.4

Note:
If the drive is set to gantry, the slave’s SW2 needs to be set to 8, otherwise it may cause gantry communication

errors.
HIWIN MIKROSYSTEM CORP. 1-13
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4.

5.

After completing station address setting, do not set up coordinate transformation at this time, which

will be set after coordinate unit in chapter 2.

Senvo

Axis No.(N) .1 |i

Axis comments(A)

Station address(D) 8 2 KV STUDIO
Extended address(E) 0 B

Mew setting data detected.
[] Automatic Parameter Reading(P) Set up coordinate transformation?

Setup(S) I Yes I I No I
__—-"——--
—
OK Cancel
Figure 1.3.5

Click PLC Transfer to import the existing setting values into the controller.

B KV STUDIO -[Editor: KV-7500] - [0615 #]
File(F) Edit(E) View(V) Program(M) ST/Script(S) Convert(A) Monitor/Simulator(N) Debug(D) Tool(T) Window(W) Help(H)

DME2PMEEE0R0 B theme - DFEP AR GESEE | § Fa Y S
I ACEREERTRRAO@ > BIIKA K Y M> 2; © B ; [Editor =

s A R 8

Project X

Figure 1.3.6

HIWIN MIKROSYSTEM CORP.
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6. Press Execute.

Transfer items(l)

Item
Unit setting info
Global device comments
Global label
CPU system setting
Program
Device default info
Loggingfrace setting info
Ethernet/serial function sefting info
File Register sefting
User document
Positioning unit parameter

REERARRRGEEREE

Unit setting info
Selectall(S) | Cancel all(D)

[]Clear program in PLC(Q)
I Caution

Transfer is conducted via Ethernet. When
unit setting information is transferred and
Ethernet sefting is changed, the
communication may be disabled.

Transfer in PROGRAM mode(P)
Transfer in RUN mode(R)

Execute(E) Cancel(C)

Figure 1.3.7

HIWIN MIKROSYSTEM CORP. 1-15
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1. Click Axis control setting and set unit of coordinate and place of decimal point. Then, click coordinate

transformation at the top.

Il KV STUDIO -[Editor: KV-7500] - [0615
File() Edit(E) View(V) Program(M) ST/Script(S) Convert(A) Monitor/Simulator(N) Debug(D) Tool(T) Window(W) Help(H)
1 |3 B =43 @ B Ethernet BV APRPOHHE S ME Y
= i & =0 B ’;Eb o) g . Editor » ' Comments Comment 1 -
Project B % || [1] Axiscontol stting X |

Viewfilter(F)  [IDisplay level] Al ~| & [E g%
B - —| AxisTET

DM10300 -
| mm)

£+ Unit on_se nit coordinate
fsdAxis control setting transformation
Po

t P

C nate transformation denominator 1
| Soft limit coordinate sysetm Logic system
| Softlimit (+). - Disable!

S tting
¥ Unit Program

Software limitcoord  |S it (+) coordinate 0.000 mim

|Softlimit(-) Disable

| Softlimit (-) coordinate 0.000 mim

| Axis error | Limit switch error setting Error
Figure 2.1

2. After setting the relevant parameters, click Advanced setting to complete the setting of encoder

resolution and servo electronic gear ratio.
The settings in Figure 2.1 and Figure 2.2 take resolution of 8388608 pulse/rev for one motor revolution

(1Tmm) and 1:1 electronic gear ratio as an example.

Coordinate transformation calculation [Axis 1:] x

Coordinate transformation setting value fitted in the operation environment is calculated.

Operation environment

Mechanic configuration(M) Ball screw pitch
Ball screw v P = 1.000
Coordinate unit(v) mm
| Gearratio Advanced setting X
Gear rauo% e n [output axis side)(0)
R = m [motor axis side](l)

= Encoder resolution(E) 8388608| PLSIrev
v Auis control common seting
rs“'; Decimal place(A) 0.001 Servo electronic gear numerator(N)
)
B:

Servo electronic gear denominator(D)

Cancel

all screw pitch (P)

Advanced setting(H)...

KV STUDIO

o Map setting?

I Execute calculation(E)

Calculation result

In operation environment, Number of PLS required for moving 0.001mm
is 8388.608

Set up coordinate transformation ratio of axis conirol commeon setting as follows.

Coordinate transformation denominator_ 1048576/

Coordinate transformation numerator 125 | Emorinfo(R)

Cancel(C)

Figure 2.2

2-2 HIWIN MIKROSYSTEM CORP.
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HIWIN. MIKROSYSTEM
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Parameters setup

3. Turn on Axis control setting and complete parameter settings in operating speed, JOG, and origin

return. Absolute position detection system is set according to the encoder: incremental type is set

to INC; absolute type is set to ABS.

* : Comments Comment 1

-

File(F) Edit(E) View(V) Program(M) ST/Seript(S) Convertid) Monitor/Simulator(N) Debug(D) Tool(M Window(W) Help(H)
4 1 2 2! =5 @ B Ethemet rBDRAPQQH BEgEE
3= o eSS E : Editor

Pioject 0 X | []Axscontolssting X
Viewfillerf)  |[Display lever Al

Note:

| Axis error

VR E e

Software limit coord | Soft limit (-) coordinate

imit swil {i{e] ing

Absolute position detection

| Stop method (operation enable relay OFF)

| Stop methed (soft limit)
| Stop method (other emors)
| Motor rotate direction
Servo OFF timing
|Servo end check ime
Backlash compensation movernent

Axis control function

Axis1 E1

Dreceleration stop

Deceleration stop
Deceleration stop
(+) operation forward pulse. .

Servo OFF aft

| Speed threshold value at the time of switching the positioning control mode

Speed switching selection

Select acceleration/deceleration sefting
| Select linear interpolation speed

Select helical interpolation speed

Comman in
position control

Select inching operation after detected stop sensor
Operation stafing speed

Max_ operation speed
Cperation accel ratefime
| Operation acceleration curve
Cperation acceleration SIN ratio
| Operation decel ratedime
Operation deceleration curve
Operation deceleration SIN ratio
JOG starting speed
|JOG high speed

Operation speed

Continuous (Curre:
Synthesi

Friorifize inchin

er axis stop
Oms
0000 mm
50 rpm

nt point s.
Ratio

ized speed

operation

|JOG accel ratefime
JOG acceleration curve
JOG |JOG acceleration SIM ratio
|JOG decel ratetime 0.010 mmyisims
|JOG deceleration curve Linear|
JOG deceleration SIN ratio | 100 5
JOG inching movement 1.000 mm
Origin retum method Immediate Z-phase origin re
Qrigin return staring speed 0,000 mmis
Crigin retum creep speed 1.000 mmis
| Origin retumn operation speed 2,000 mmis
| Crigin retumn accel ratefime 0.010 mmisims
Origin return acceleration curve S
| Origin retum acceleration SIN ratio 100 %
Origin return decel ratefime 0.010 mmisims
Origin return | Origin return deceleration curve SN
Origin refumn deceleration SIM ratio 100 %
| Origin return direction (-) direction
Origin coordinate 0.000 mm
| Movement after DOG ON r
| Crigin return dwell time 0ms
| Torgue threshold time _om
Torque threshold 100
i 0

Figure 2.3

The highest operation speed must be equal to the rated operation speed of the motor. The setting of origin return,

JOG, operating starting speed, high speed, acceleration and deceleration rate/time, and acceleration curve are

based on the same concept, which will be describe in detail in chapter 3. The unit of 1 mm/s here indicates that the

motor speed is 1 rev/s (60 rpm).

HIWIN MIKROSYSTEM CORP.
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4. After the parameters are set, click PLC Transfer and switch KV STUDIO mode to Monitor.

Bl KV STUDIO -[Editor: KV-7500] - [0615 #]
File(F) Edit(E) View(V) Program(M) ST/Script(S) Convert(A) Monitor/Simulator(N) Debug(D) Tool(T) Window(W) Help(H)
e B P RE :

CERE

=(a@ n Ethernet

TR Y

- B W

B X || [1]Asiscontolseting X

1o . B 0l o s A AL L <

gotor ] comments Commen >

n Monitor

View filter(F)

|[Display level] All

Online edit

/ Simulator

Simulator edit Axis1E1

| Unit coordinate
AR P

LN

Update time in PLC and ladder diagram/program is different, so could it not be transferred to PLC, but transferred to monitor directly?
Monitor mode(M) PLC transfer -> monitor mode(T) Cancel "

}y_nit of coord
| Place of decimal point
| 360 degree display

Softlimit (-)

D\Sablé
Soft limit (-) coordinate 0.0 m

| Axis error

Limit switch error sefting Error|

| Axis contrel function

‘Absolute position detection system ABS B
Stop method (operation enable relay OFF) Deceleration stop
Stop method (soft limit) Deceleration stop
Stop method (other errors)
Motor rotate direction

Deceleration stop
(+) operation forward pulse..

Figure 2.4

5. To save this project, switch KV STUDIO mode to Editor, and click File > Save project or Save project

as and set project name and position to complete the archive.

Bl 1o STUDIO -[Editor: Kv-7500] - [0615 ]

Register sensor settings file(E)...
Import(l)
Memory card (M)

Save device comments in CSV/TXT format(k)...
Read device comments in CSV/TXT format(Q)...

Mnemanics list(R)

Cutput CSW/TXT file(U)
HTML file output(T)

W Edit(E) View(N) Program(M) ST/Script(S) Convert(A) Monitor/Simulator(N) Debug(D) Tool(T) Window(W) Help(H)
[T New project(N).. aihh S PRFABPGH%EGS FRREH DS
% Opép praject(d)... Ctrl+Q Bl Editor .

Closéﬁroject(f:) - "

| Save project(s) Ctrl+5 ontiel et
Save project as(A)... ter(F)  Save project as e
Save compact project())... < Project name(N) PLC model(K)
Verify project(B)... 0615 KV-7500
Project property(F)... ?r;dz;gzﬁ _PD;mBU(f)

C:‘.Usarsfpay_lisakin g\Documents\KEYENCEKVS 11 Guvs| Refer(S)...
L . J

Comment(C)
re limit
| Detai®) Cancel
AMUIUIULE PUsiuul] UeleLlun ayaweind
Stop method (operation enable relay OFF)
Stop method (5oft limit)
Stop method (other errors)
Figure 2.5
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Supplementary note:

If users use KV STUDIO for the second time and would like to adopt the previous project, please click

File > Open project and select the previously set project or click the area in orange boxes in Figure

2.7 to read the previous PLC project.

Bl kv sTuDiO
File(F) l\ﬁew(V) Monitar/Simulator(N)

Operation recorder/Replay(R) Tool(T) Window(W) Help(H)

Cr+N PPAPONKESEE L P E R LY

D L New project(N)...

G HAKIN YW >O U D m |

Register sensor settings file(E)...

Memory card(M)

Printer setup(W)...

Recent projects(D)

Exit(X)

Bl kvsTupbio
File(F) View(V) Monitor/Simulator(N)
DeEBE2PRE=0R O

S cthemet
g E2ERRBIDRE @@ > B I KA |< 3

Figure 2.6

Operation recorder/Replay(R) Tool(T) Window(W) Help(H)

Read items(l)

[Communication destination: K\-7500,
route: Ethernet 192.168.0.10]

ltem /|

Program

NERRKNRNRRHRKRKRE

Unit setting info

Global device comments
Global label

CPU system setting

Device defaultinfo
Loggingfrace sefting info
Ethernet/serial function sef
File Register setting
User document
Positioning unit para
Device value

HIWIN MIKROSYSTEM CORP.
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' seléctall(s)/ Cancel allD)
| 4 | 4
[ Execute®) || canceic) |

Figure 2.7
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3.1 Positioning control

1. Check if the KV STUDIO mode is Monitor. Click the positioning motion unit set by the parameter and
right-click > Trial run > Positioning control > Axis.

Bl kv STUDIO -[Monitor: KV-7500] - [0615 #]
File(F) Edit(E) View(V) Program(M) ST/Script(S) Convert(d) Monitor/Simulator(N) Debug(D) Tool(T) Window(W) Help(H)

2 |J 0 &l |Ethernet T q = =] ) !
$PEERIB23 60 > e
Project J %X [1] Axis control sstting X
ViewfiterF)  |[Display levell Al |l BB =% @
) | Axis1:E1
Soft limit (+) : Disable
: Soft limit (+) coordinate |
## Unit common s¢ Device assignment display(D) Soft limit (-) Disable
£ Axis control g . . Soft limit (-) coordinate
Point paramets Unit monitor(C) Limit switch error setting Errol
TR GReE Absolute position detection system T -
; . 9 Sion mathad (nacalinn anabla. felay DEE : | Deceleration stop
& Unit Program | _ Trial run(T) » || Positioning control(P)  » | Asis1(1) | | Deceleration stop
Option setting Synchronous contral(S) bl Speed control(S) 3 Deceleration stop

(+) operation forward pulse...

=~ Unit configuratiy Slave apparatus restart(E) Torque control(T) > Servo OFF after axis stop
B Device comment Servo end check time oms
Ed Label Backlash compensation movement 0.000 mm

.| CPU system setting Speed threshold value at the time of switching the positioning control mode 50 rpm

= M Program: 0615 Speed switching selection Continuous (Current points...
=l -y-scan execution Commonk Seledt accelerationideceleration sefting ) Ratio
LR

Figure 3.1.1

2. Check if “Axis error” turns to red light. If there is an error, click Error clear first; if there is no error,
click Cancel OP. Enable. When "Operation ready" turns to green light, click Cancel servo ON and
wait for “Servo ready” light to turn green. The action sequence cannot be reversed. After completing
"Servo ready", users can execute JOG movement in forward and reverse directions.

Axis1  command coordinate Axctrl in progress Operation ready | Cancel OP. Enable

Servo rea Cancel servo ON

Wa — e i
Wait — s error _ Emorclear

Current pointro 0

J0G e Inching Origin return

< > gy 4D O

- direction +direction  10% 100% - direction + direction
Teaching Trial run
® 1 point operation (O Cont operation

Point number 1l Point number 1 | 15 |Wait None A

Coord 0.000 mm Coord. 0.000 mm < |Wwait None

Speed 1.000 mmis < |Wait: None

Mode Single/PositionINC + |Wait: None >

r' Acquire P star [ Deceistop | | Jll Force Stop
Figure 3.1.2
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3.  When JOG is moving, users can open Scope in Thunder, select “7. Motor velocity” to check the
speed feedback of the motor, and check if the set speed command is consistent with actual speed
feedback of the motor. According to 5.00 mm/s JOG high speed set by the parameter, the
corresponding speed is 300 rpm.

&

Speed
(rpm)

JOG starting speed

JOG high speed

JOG accel rateftime

JOG acceleration curve
JOG acceleration SIM ratio
JOG decel ratetime

JOG deceleration curve
JOG deceleration SIN ratio

[ 00160177 rpm
Figure 3.1.3

Note:

(1) If users would like to achieve the position, speed, acceleration, and deceleration set by the positioning motion
unit in equal proportion, please set drive parameter electronic gear ratio Pt210 and Pt20E to 1:1.

(2) Thunder 1.9.20.0 or above and drive firmware version 2.8.16 or above support the electronic gear ratio setting

other than 1:1.
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3.2 Starting speed, acceleration and deceleration rate/time,

acceleration curve

1. Complete the parameter setting in Figure 3.2.1 with the above-mentioned setting method.

JOG starting speed 1.000 mm/s
JOG high speed 25.000 mm/s
JOG accel rateftime 0.010 mm/s/ms
JOG acceleration curve SIN
JOG JOG acceleration SIN ratio 100 %
JOG decel rateftime 0.010 mm/s/ms
JOG deceleration curve Linear
Figure 3.2.1

2. Open Thunder > Tools > Real-time data collection and click Start to capture the speed command
dPosVelCmd.

File Settings Access Help

r 1
Real-time data collection 2.185

File Tools Sessions

dPosVelCmd

/sample { 4 bytes )

Figure 3.2.2
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3. Execute JOG movement in forward direction for a few seconds and release it, wait for the motor to
stop.

Trial run [Positioning control]- Unit1 - Awxis1:E1 - KV-XHO4ML -4

Axis Command coordinate

Ay ctrlin progress Operation ready Cancel OF. Enable

1 09 7 003 mm Servo ready . Cancel servo ON

Wait ) .
Axis error Error clear
Current point no: 0

JOG Inching Origin return

Speed 1005 %

< | D> vy 4 » )

- direction +direction  10% 100% - direction + direction
Teaching Trial run
(@ 1 point operation () Cont. operation

Point number 15 Point number 1% 1 5 |Wait None l

Coord.  0.000 mm Coord.  0.000 mm - | Wait None

Speed 1.000 mmis + | Wait: None

Mode Single/Position/INC + | Wait: None v

r' Acquire b Start B Decel Stop [l Force stop
Figure 3.2.3

4. Open Thunder > Tools > Real-time data collection, click Stop and then press Graph (refer to
Figure 3.2.2) to generate Figure 3.2.4.

Speed

1400)

(rpm) 1300

1200)

1100)

1000)

800

800

700

600

Figure 3.2.4
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5. According to the setting in chapter 2 that the resolution for one motor revolution (1mm) is 8388608
pulse/rev, 1.00 mm/s starting speed corresponds to 60 rpm actual speed; 25.00 mm/s JOG high
speed corresponds to 1500 rpm actual speed.

Choose SIN for acceleration curve since the speed command from starting speed to high speed is in
a curved shape; choose a straight line for deceleration curve since the speed command from high
speed to starting speed is in a straight line.

The acceleration/deceleration time of 0.010 mm/s/ms corresponds to actual acceleration of 0.6
rpm/ms, indicating that the speed increases by 0.6 rpm every 1 ms.

Speed - high speed
(rpm) [
1000] I
/
'J(.f
acceleration curve / deceleration curve
/
/
,/JOG starting speed 1.000 mmv/s
JOG high speed 25.000 mm/s
JOG accel rate/time 0.010 mm/s/ms
] JOG acceleration curve SIN ]
- | Starting speed JOG acceleration SIN ratio 100 % Starting speed
0 JOG decel rateftime 0.010 mm/s/ms
JOG deceleration curve Linear

Time (sec

Figure 3.2.5
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4.  Origin return

..................................................................................................................................................... 4-1
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4.1 Immediate Z-phase origin return

1. Use the above-mentioned setting method to complete the setting of origin return method and direction

in Figure 4.1.1.

Origin returmn method Immediate Z-phase origin retfum
Ongin return starting speed 0.000 mm/s
Origin return creep speed 5.000 mm/s
Origin return operation speed 5.000 mm/s
Origin return accel rate/time 1.000 mm/s/ms
Origin returmn acceleration curve SIN
Origin retum acceleration SIN ratio 100 %
Origin return decel rate/ftime 1.000 mm/s/ms
Origin retum Orig?n return decelerat!on curve SIN
Origin return deceleration SIN ratio 100 %
Origin retumn direction {-) direction
Origin coordinate 0.000 mm
Figure 4.1.1

Note:

Immediate Z-phase origin return can be used without any external input signal. This method can be adopted if
users cannot input external P-OT, N-OT, DOG, EXT-PROBE1 signals to the drive. If users would like to use
external P-OT, N-OT, DOG, EXT-PROBE1 signals for origin return, 1/O setting of the drive must be completed first.

(For detailed information, please refer to " E Series Servo Drive Thunder Software Operation Manual.")

2. After"Operation ready" and "Servo ready" turn to green light, click Origin return. The motor will move
in origin return direction and search for the encoder origin (index). It will stop after finding the origin.

Axis1  command coordinate i ctrl i s ati ady | Cancel OP. Enable

Cancel servo ON

Axis error " Emorclear

Current point no:

Joc Inching Origin return

Ongin return method Immediate Z-phase origin refum Speed 1002] o
Origin return starting speed 0.000 mm/s 0
Origin return creep speed 5.000 mm/s ( ) {I I’ o
Origin return operation speed 5000 mm/s '
Origin return accel rate/ime 1.000 mm/s/ms
Or!g!n Lei accelelal!nn ENrE SIN - direction +direction  10% 100% - direction + direction
Origin return acceleration SIN ratio 100 %
Origin return decel rate/fime 1.000 mm/sims
Origin retum Or@g@n return decelerat@un curve gjN  Teaching TEdT
Origin return deceleration SIN ratio 100 % (® 1 point operation () Cont. operation
Origin return direction (-) direction —
Origin coordinate 0,000 mm  Pointnumber 15 Point number 1 1% |Wait: None A
Coord 0.000 mm Coord 0.000 mm Wait None

Speed 1.000 mmis Wait: None

R EGREORED

Mode Single/Position/INC Wait: None v

r’ Acquire P statt B Decel Stop Bl Force Stop

Figure 4.1.2
Note:

When using with an incremental encoder, users need to check if the encoder supports index signal output.
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Origin return

4.2 Limit switch rising edge

After "Operation ready" and "Servo ready" turn to green light, click Origin return. When the motor moves

in reverse direction, after touching N_OT signal, it will immediately move in forward direction and exit from

the signal. After disengagement, the motor will move in reverse direction again and stop until it reaches

N_OT. This origin return method only supports in reverse direction.

Origin return

Origin retumn method

Origin return starting speed

Origin return creep speed

Origin return operation speed
Origin return accel rate/time

QOrigin retumn acceleration curve
Origin retum acceleration SIN ratio
Origin return decel rate/time

Origin return deceleration curve
QOrigin retum deceleration SIN ratio
Qrigin retum direction

QOrigin coordinate

HIWIN MIKROSYSTEM CORP.

Axis1  command coordinate

o = - JoG
Limit switch rising edge

0.010 mm/s
os00mms | € >
0.500 mm/s
0.100 mm/s/ms - direction +direction  10%
SIN
100 % Teaching
0.100 mm/s/ms

SIN  Pointnumber 1
9
- 109 % Coord, 0.000 mm
(-) direction
0.000 mm Speed 1.000 mmis

’ Mode Single/Position/INC

r’ Acquire

Figure 4.2.1

®  Operation ready | Cancel OP. Enable
Cancel servo ON

| Error clear
Current point no: 0

Inching Origin return

Speed 1005 %
a @ » O
L
100% - direction +direction
Trial run

(@ 1 point operation (O Cont operation

Point number 1 1% |Wait: None @
Coord.  0.000 mm < | Wait: None

< | Wait. None

5| Wait None

v

P start B Decel stop B Force stop
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4.3 Origin sensor and Z-phase

After "Operation ready" and "Servo ready" turn to green light, click Origin return. When the motor moves
in reverse direction, after touching EXT-PROBE1 signal of origin sensor, it willimmediately move in forward
direction and exit from the signal. After disengagement, the motor will move in reverse direction again and
stop until it reaches EXT-PROBE1 signal of origin sensor.

Origin return method

Origin sensor and Z-phase!

Axis1

Command coordinate

Cancel OF. Enable

Cancel servo ON

Error clear

Origin return starting speed 0010 mm/s 406 [T PrioeRese
Ongin return creep speed 0.500 mm/s Speed 1003 %
Origin returmn operation speed 0500 mm/s r'4 > 4 i E)
Origin return accel rateftime 0.100 mm/s/ms L
Ongin return acceleration curve SIN
Origin return acceleration SIN ratio g | echionl - diecton 0% 100% CIEED  SEIGERT
Or@g@n return decel rateﬁime 0.100 MM/S/IMS  1oaching Trial run
S = Or!g!n retum deceleral!on curve S\ON O O ® GG
Origin returmn deceleration SIN ratio 100 % = . = o
Ep - - = - Point number 15 Point number 1% 1.5 |Wait: None A
Origin return direction (-} direction
Origin coordinate 0000 mm  Coord 0.000 mm Coord 0.000 mm < |Wait: Nene

Supplementary note:

Speed 1.000 mm/s

Mode Single/Position/INC

r’ Acquire

Figure 4.3.1

+|Wait None

< |Wait None
v

’ Start B Decelstop B Force Stop

1. The above are the three origin return methods supported by Keyence positioning motion unit. For other
methods and detailed information, please refer to chapter 8 in "KV-XH16ML/XH04ML User's Manual."
2. The origin sensor and DOG signal for origin return will correspond to EXT-PROBE1 input signal of the

drive.

3. EXT-PROBE1 related functions are only supported by Thunder 1.9.20.0 or above and drive firmware

version 2.8.16 or above.
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